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1. 关于本文档
1.1 版本信息
本文档提供用于安装、配置和使用维萨拉边界层视图软件 BL-View 的信息。
表 1 文档版本（简体中文）

文档代码 日期 说明
M211185EN-D 2018 年 11 月 版本 2.1.1 包含以下新功能：

• 最高到 15400 米（50520 英尺）的完整云高仪配置文件
• 英语/中文的语言选择
• 计划的快照

M211185EN-C 2018 年 6 月 版本 2.1 包含以下新功能：
• 支持多个云高仪
• 嵌入的 CL-VIEW 功能
• 添加到 HIS 文件的混合层高度信息
• 用户界面更新

M211185EN-B 2017 年 6 月 版本 2.0 包含以下新功能：
• 新算法
• 1 小时平均混合层高度
• NetCDF 数据文件
• 与云高仪的 TCP/IP 连接
• 对用户界面的视觉更新
已删除的功能：BL-View PostgreSQL 数据库。

此 Vaisala Boundary Layer View Software BL-View User Guide 有如下两种形式：
• BL-View 软件包含在线帮助（自 2.0 起）。
• USB 盘包含联机帮助和 PDF 帮助。
PDF 中和在线提供的帮助内容完全相同。

1.2 相关手册
表 2 相关手册

文档代码 名称
M210482EN Vaisala Ceilometer CL31 User Guide
M210801EN Vaisala Ceilometer CL51 User Guide
M212160EN BL-View NetCDF Example File Technical Reference

章节 1 – 关于本文档
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1.3 文档约定
警告字样提醒用户注意严重的危险。此时需要仔细地阅读说明并严格按照说明进

行操作，否则可能会造成人身伤害甚至死亡。
警告

小心字样提请用户注意潜在的危险。此时需要仔细阅读说明并严格按照说明进行
操作，否则可能会造成产品损坏或重要数据丢失。
警告

注意字样强调有关使用产品的重要信息。

提示提供用于更高效使用产品的信息。

列出执行该任务所需的工具。

指示您在执行该任务过程中需要记一些笔记。

1.4 商标
AviMetâ 是 Vaisala Oyj 的注册商标。
Vaisalaâ 是 Vaisala Oyj 的注册商标。
Microsoftâ 和 Windowsâ 是 Microsoft Corporation 在美国和其他国家/地区的注册商标
或商标。
本出版物中可能提及的所有其他产品名称或公司名称是各自所有者的商品名称、商标或注
册商标。

BL-View 用户指南 M211185ZH-D
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2. 维萨拉边界层视图软件 BL-View
维萨拉边界层视图 BL-View 是用于大气边界层分析和可视化的软件应用程序。它是设计用
于维萨拉云高仪 CL31 和 CL51 的独立的数据收集、存储、分析和演示工具。

图 1 维萨拉边界层视图软件 BL-View

使用准确的边界层可视化改进决策
大气边界层高度也称作混合层高度 (MLH)，它与城市排放源强度、交通排放和天气影响一
起，是用于确定空气污染性质的关键参数。因为排放和其他近地表污染物在大气边界层内
沿垂直方向削弱，所以，对 MLH 进行监测对于评估污染物的特性、转化和清除至关重
要。它还是数字化空气污染模拟验证的必需参数。
BL-View 生成 MLH 的在线可视化再现图像，让您即时了解当地条件。此外，还可将 MLH
数据无缝整合到数字气象预测模型。您可在记录和显示实时数据的同时，查看和分析记录
的数据。BL-View 出色的观察能力，可帮助提高您的空气质量监测和预报能力。
全天候的可靠数据
维萨拉云高仪测量大气的后向散射廓线，并且提供用于在 BL-View 上进行分析的廓线。该
软件具有自动算法以便对边界层深度和附加残留结构进行在线检索。BL-View 计算基于综
合的梯度和理想化的后向散射方法，实现对流混合层高度 (MLH) 的可靠的自动报告。该算
法还考虑到了时间和位置，以便改进所有情况下的自动报告。
与空气质量最相关的层报告为 MLH。在通常情况下，该层跟随对流层。但是，在某些情况
下，如果在对流层内形成了较强的附加层，则由于它捕获到所有排放并因此与空气质量最
相关，该层将报告为 MLH。为了确保各种气象条件下的报告可靠性，BL-View 还采用了考
虑到可能出现的降水和云事件的全天候算法。

章节 2 – 维萨拉边界层视图软件 BL-View
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快速数据分析
维萨拉 BL-View 与运行 Microsoft Windowsâ 的计算机兼容。云高仪和计算机之间的通信
通过以太网或串行线路进行，并且云高仪信息以 netCDF 格式存储在计算机硬盘上。借助
该格式，可以轻松快捷地进行数据分析和共享。自动分析的边界层数据存储在容易转移到
其他应用的日志文件中，例如作为数字气象预测模型的输入。
灵活的用户界面
云高仪后向散射廓线数据由默认参数自动进行分析，以便报告对流混合层高度 (MLH) 和其
他边界层结构，例如残留边界层高度。除了实时 MLH 报告之外，该软件还报告每小时平
均 MLH。
可以使用用户设置的算法参数同时运行运营商特定的分析。可以使用任何用户设置的参数
对存储的廓线重新进行分析，而不会影响实时数据分析和可视化。
清晰的图形用户界面带来简单便捷的多重处理。运营商可在详细分析中放大任何一点。在
主屏幕上永久显示云高仪和通信的状态，以便调查可能的操作警报。这些警告和警报也自
动存储到日志文件，便于检索。

2.1 支持的云高仪
BL-View 支持最多 10 个云高仪。维萨拉云高仪 CL31 和 CL51 可以连接到 BL-View。
更多信息
‣ 将云高仪添加至 BL-View (页 27)

2.2 系统最低要求
表 3 系统最低要求

组件 最低要求
计算机 以太网端口、串行端口或 USB 串行转换器
操作系统 Windows 10 Pro

Windows 10 Pro Enterprise
Windows 7 Ultimate（32 位或 64 位）
Windows 7 Professional（32 位或 64 位）

RAM 2 GB
硬盘空间 对于 BL-View 安装：600 MB

对于 BL-View 数据文件：40 GB / 年 / 云高仪（典型）
所需的总硬盘空间量取决于云高仪的数目

请勿在 AviMet 自动气象观测系统或 Vaisala Observation Network Manager NM10 所
在的计算机上使用 BL-View。

BL-View 用户指南 M211185ZH-D
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2.3 许可
BL-View 需要软件许可证才能运行。要激活该许可证，您需要一个产品密钥。
在您购买软件时，维萨拉会提供产品密钥。如果您购买了软件但未收到产品密钥，请与维
萨拉公司联系。
许可证已映射到硬件。如果您的硬件发生变更，需要重新安装 BL-View，您必须从维萨拉
代表申请一个更换许可证。
许可证可以涵盖一台或几台设备。在激活许可证后，您可以在 BL-View 中添加设备。
对于许可证更新和新许可证，请与维萨拉联系。
Vaisala License Manager 用于激活维萨拉软件许可证。许可证只允许激活一次。

章节 2 – 维萨拉边界层视图软件 BL-View

9



BL-View 用户指南 M211185ZH-D

10



3. 运行原理
大气边界层（或大气边界层）是地球大气的最低部分。它直接受到其与地球表面接触的影
响。大气边界层以 1 小时或更小的时间刻度对热传递、污染物排放和其他表面加压做出响
应。
大气边界层的深度取决于地点、季节、一天中的时间以及天气等。通常，大气边界层从地
球的表面延伸 50 … 3000 米（164 ... 9840 英尺）。雾气、霾、薄雾、烟雾和空气污染是
大气边界层中的典型现象。
大气边界层包含若干层类型：

• 对流边界层：由于机械和热效应微粒在其中很好地混合的空气层。对流边界层的深度
称作混合高度。

• 夜间边界层：在日落时分形成的稳定空气层。其顶部通常由逆温标记。该层通常在清
晨时被对流消除，但在来自太阳的热量不足以使夜间边界层消散时在白天也可能保
持。

• 残留层：包含之前对流边界层在日落后遗留的微粒或由风远距离输送的微粒的空气
层。

• 近地层：与地面最接近的空气层。其厚度通常为 50 ... 100 米（164 ... 328 英尺），大
约为边界层高度的 10 %。

3.1 大气边界层中的昼夜变化
大气边界层中日间发生的变化被称为昼夜变化。
以下现象影响该层的形成：

• 太阳辐射加热地球的表面，导致热空气的气流从地面上升。
• 大气边界层顶部的云的辐射冷却生成降低的冷空气气流。
• 大气边界层顶部的风切变有助于产生湍流。

在日间，昼夜变化对大气边界层有以下影响：
1. 空气中的湍流由太阳辐射和辐射冷却导致，太阳辐射和辐射冷却是同时发生的。在夜

间，表面的辐射冷却控制着边界层，形成夜间层。夜间层阻止近地层和残余层之间的
干扰。在日出前，夜间边界层高度是混合高度。

2. 日出后，太阳辐射使地球表面变得不稳定，形成上升的热空气气流。热空气气流继续
上升，直到其温度下降到与周围空气温度相同。
同时，冷空气气流从云顶部下降。形成的湍流导致热量、湿度和微粒在对流边界层中
均匀混合。对流边界层在下午晚些时候达到最高混合高度。
夹卷层充当对流边界层和自由大气层的交界面。在此区域的大气层中，从上方来的湍
流气流与对流边界层混合。
对流边界层到达与残余边界层交汇的地方时，两个层混合在一起。这对于时间和空间
上的空气污染传输是重要的过程。水平扩散和传输对于空气质量有重大影响。

3. 日落时，辐射冷却导致对流边界层瓦解。形成新的夜间边界层，在第二天它再次被新
的对流边界层取代。

章节 3 – 运行原理
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图 2 大气边界层结构和昼夜变化

3.2 边界层分析
云高仪在垂直方向或接近垂直方向上发出功率强大的短激光脉冲。在激光脉冲穿过天空时
测量由霾、雾、轻雾、雨幡、降水、气溶胶和云引起的光反射（称为后向散射）。
后向散射廓线（即信号强度与高度比）被存储和处理，使用该数据计算云底和大气边界层
结构。
大气边界层是低空大气的一部分，在此层中、风、温度和湿度受地球表面的强烈影响。此
层也称为混合高度层，它的厚度对于分析大气层状态很重要，例如在空气质量评估和航空
方面。
后向散射信号在微粒浓度更高的大气边界层中通常更强，但是在自由大气层（它通常具有
更少的微粒）中更弱。BL-View 检测大气边界层和自由大气层之间的后向散射梯度（混合
高度）以及其他大气层结构（例如残余边界层以及可能产生强后向散射梯度的升高的烟雾
或气溶胶羽流）。
在大气层结构中，为了将灵敏度降低到噪声和瞬时状况层面，BL-View 对云高仪数据执行
垂直和时间平均。
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图 3 来自对流边界层的后向散射廓线

3.3 混合高度算法
BL-View 使用 3 种不同的算法：

• 梯度
• 廓线拟合
• 合并式梯度和廓线拟合

梯度方法
梯度方法可检测到最多 3 个悬浮微粒层，并且在许多情况下表现优异，尤其是高于地平面
少于 500 米（1640 英尺）的浅夜间边界层。
廓线拟合方法
廓线拟合方法仅检测单个层，并且在气溶胶后向散射信号较弱时、本地梯度较弱并且散射
时以及昼夜转换期间边界层随时间迅速发展时，成功评估混合高度。
合并式梯度和廓线拟合方法
合并式梯度和廓线拟合方法吸取了梯度方法和廓线拟合方法的优点，但保留了在后向散射
廓线中检测到多个层的能力。该合并式方法使用以下规则选择从梯度和廓线拟合检索中获
取的混合高度：

章节 3 – 运行原理
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• 梯度方法的对云廓线以及窄的高质量边界层的最低检索
• 在所有其他情况下的廓线拟合检索（不显示梯度方法的最低检索，除非差异超过

1000 米（3280 英尺））。
• 在所有情况下均显示第二个和第三个梯度检索，因为它们可能指示残留层或其他高空

气溶胶层。
该算法可以可靠标识不同边界层，例如夜间、对流、海洋和残留层，并且将混合层与 BL-
View 检测到的气溶胶层进行区分。它还提供异常值剔除方法、云过滤器和其他更改，以
便提高夜间边界层转换性能以及增加用于处理来自 CL31 和 CL51 云高仪的数据的灵活性
和稳健性。
该算法通过将后向散射廓线拟合到观察到的范围更正云高仪后向散射廓线，确定混合高
度。云和降水生成显著偏离理想廓线的后向散射廓线，从而导致不佳的混合高度评估。即
使在后向散射廓线显著偏离理想廓线的情况下，该算法也可以生成有效检索。
在某一云高仪检测到多个气溶胶层时，该算法把 1 个气溶胶层归为混合高度。在存在多个
气溶胶层时，最低层是最先的合理猜测，将这些层之一归为混合高度。
更多信息
‣ 创建计算预设 (页 69)
‣ 修改计算预设 (页 71)

3.3.1 云和降水过滤器
云过滤器避免后向散射廓线中云或降水导致的可疑的混合高度检索，尤其是在高于地平面
的高度不到 4000 米（13123 英尺）时。

• 在梯度方法中，云和降水会生成较强的本地梯度，可能与混合高度无关。
• 在廓线拟合方法中，云和降水生成显著偏离理想廓线的后向散射廓线，从而导致不佳

的混合高度评估。
云过滤器会显著改进混合高度评估，并且消除早晨地面附近有云和强后向散射时的检索。
在以下一个或多个情况存在时该算法不会报告混合高度：

1. 在高于地平面不到 160 米（525 英尺）的天空中存在云。
2. 在后向散射廓线中检测到降水或过高的后向散射。
3. 在高于地平面不到 4000 米（13123 英尺）的天空中存在云，并且在低于 1000 米

（3280 英尺）的天空中有过多的后向散射。在存在较窄的低于 4000 米（13123 英
尺）、但高于 160 米（525 英尺）的非降水云时仍允许检索。

3.3.2 变化平均
长的平均间隔帮助防止收到信号噪声生成的假梯度最小值。但是，此方法降低了算法对空
间和时间上的短标度信号波动的响应能力。信号噪声量取决于日间的范围和时间。梯度法
提供变化平均参数。
BL-View 默认设置使用接近地面的 80 米（262 英尺）高度平均值。此间隔逐渐增加到
1500 米（4920 英尺）以上的高度所使用的 360 米（1181 英尺）平均值。
所选的时间平均间隔取决于信号噪声。它在夜间的 14 分钟和明亮的多云日间的 52 分钟之
间变动。
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3.3.3 变化阈值
气溶胶含量高的对流边界层内的小密度波动与干燥的乡村环境中的层顶部相比，可能具有
更低的梯度值。
BL-View 通过使用变化阈值（它取决于边界层的平均后向散射信号）来防止将这些波动报
告为气溶胶层顶部。仅当其值低于阈值时，才报告本地梯度最小值。

3.3.4 异常值剔除
异常值剔除功能过滤掉由仪器噪声、瞬时小型气溶胶特征导致的假混合高度检索值或传统
平均技术无法剔除的其他项目。但是，它保留整个日间边界层变化的重要详细信息。
为了避免剔除有效的混合高度，该算法放宽了品质因数的标准，以便将有效的检索值与异
常值区分开。对于每个检索值，异常值剔除方法基于与前四分钟内的其他检索值的接近度
（高度方面）计算品质因数分数。该算法将具有不足邻近项数（品质因数分数低）的检索
值视为异常值，并用最新的有效检索值来替代它们。

3.4 天气情况的影响
以下气象条件影响大气边界层结构的分析。
降水
在降水期间，无法报告混合高度或其他气溶胶层。这是因为后向散射中降水具有很强的信
号，它盖过了任何其余气溶胶层的信号，使系统无法将这些信号与降水信号区分开。
低层云
低层云位于 0 … 2000 米（0 ... 6560 英尺）的高度处。如果有低层云，混合高度通常位于
云的顶部。在这些情况下，受维萨拉云高仪 (LIDAR) 的测量原理所限，BL-View 不显示真
正的混合高度。在正常情况下，报告的本地梯度最小值与云顶部的偏差通常小于 200 米
（656 英尺）。
中层和高层云
中层云位于 2000 … 5000 米（6560 ... 16400 英尺）的高度处，高层云位于 5000 米
（16400 英尺）以上的高度处。中层云和高层云通常不会给混合高度测量带来任何问题。
以正常方式从采集的数据报告混合高度。
雾气或基于地面的遮蔽
雾气或基于地面的遮蔽影响混合高度测量。
如果雾气或基于地面的遮蔽太密，激光无法穿过该层，这使得估计混合高度非常困难。
在这些情况下，维萨拉云高仪通常报告可收到后向散射信号、具有最高海拔高度的垂直能
见度读数。如果信号不够强，将自动报告混合高度读数。

章节 3 – 运行原理
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4. 安装
如果您在将 BL-View 安装到具有之前版本 BL-View 的计算机，请首先执行以下过程：

1. 备份 BL-View 数据 (页 17)
2. 卸载 BL-View (页 18)

新安装（不具有 BL-View 的计算机）：
• 安装 BL-View (页 19)

4.1 备份 BL-View 数据
• 如果您使用的是 BL-View 1.1 或更低版本，请在卸载以前版本的 BL-View 前备份所有

BL-View 数据。
• 如果您使用的是 BL-View 2.0 或更高版本，请备份 netCDF 文件。建议定期备份

netCDF 文件。

这些说明对于 BL-View 1.1 或更低版本有效。

1. 在您的计算机上，选择开始 > 命令提示符。
2. 要转到 BL-View PostgreSQL 文件夹，请键入： 

cd c:\BLView\Postgresql

章节 4 – 安装
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3. 要备份 BL-View 数据库，请键入文件夹和文件名： 

take_backup.bat <备份文件夹路径>\<备份文件名>

例如：

take_backup.bat c:\temp\blv_backup.dmp

为了避免丢失数据，请不要将备份文件保存在 BL-View 或 BL-View 数据库安
装文件夹（C:\BLView 和 C:\Postgresql）中。
警告

BL-View 数据库将备份并保存到所选备份文件夹中。
4. 关闭命令提示符。

如果您无意中卸载了数据库，请手动从该备份文件重新安装它。

4.2 卸载 BL-View
在卸载 BL-View 前，请备份 BL-View 数据。警告

卸载 BL-View 不会删除从您的计算机收集的数据。

1. 查看您的当前 BL-View 安装中的设置并且记下这些设置或创建屏幕截图。
2. 选择开始 > 控制面板。
3. 根据您的计算机的操作系统，选择添加或删除程序、程序和功能或类似功能。
4. 选择 BL-View > 卸载。
5. 按照屏幕上的说明操作。
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4.3 安装 BL-View
请在不包含任何以前版本的 BL-View 的计算机上安装 BL-View。否则，您可能丢

失现有 BL-View 文件。
警告

要在您的计算机上执行安装，请以管理员身份登录。

1. 将 USB 盘插入您的计算机上的 USB 端口。 
BL-View 安装程序将在几秒后自动启动。如果安装未自动启动，请双击 USB 盘上的可
执行 (EXE) 文件。

2. 按照屏幕上的说明操作。 
将 BL-View 安装到以下文件夹：C:\Program Files (x86).

3. 要激活 BL-View，请在 License Manager 中按屏幕上的说明操作。使用附信中的产品
密钥。 
如果运行 BL-View 的计算机未连接到 Internet，请参见在没有 Internet 连接的情况下
激活许可证 (页 19)。

4. 要完成并验证安装，请重新启动计算机并打开 BL-View：开始 > （ > 所有程序 > ） > 
Vaisala > BL-View > BL-View。

如果您选择使用试用版许可证，在打开 BL-View 时可以看到试用版许可证将在多少天后到
期。试用版许可证支持添加 1 台设备。

4.3.1 在没有 Internet 连接的情况下激活许可证
如果运行 BL-View 的计算机未连接到 Internet，必须使用另一联机计算机激活许可证，然
后将许可证文件传输到 BL-View 计算机。
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19



在开始前，请确保您具有用于存储所获得的许可证文件并将其传输到其他计算机的存储设
备，例如 USB 盘。

1. 在 License Manager 打开时，选择 Continue。 

2. 键入产品密钥。产品密钥位于附信中。选择 Continue。 

3. 将打开一个窗口，其中包含“无连接”信息。
a. 记下该产品密钥以及显示的请求代码，或选择 Save codes as txt 以将代码作为

TXT 文件保存在您可以随身携带的媒体中，例如 USB 盘。
b. 不要关闭 License Manager 窗口，您以后将需要使用 License Manager 上传许可

证文件。
4. 携带 USB 盘并且转到连接到 Internet 的另一台计算机，转到 https://

licensing.vaisala.com。
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5. 在 Login Using 中，选择 Product Key 并键入产品密钥。选择 Login。 

6. 在打开的窗口中，选择 Product Details > Activate。
7. 在 Primary 1 info 中键入请求代码，然后选择 Generate。 

如果请求代码包含星号，请确保包括它。
8. 将生成许可证文件。选择 Save to File 以将许可证文件 (lservrc) 保存到可传输到

系统的媒体中，例如 USB 盘。
9. 携带 USB 盘回到仍打开着 License Manager 窗口的计算机。

章节 4 – 安装

21



10. 要将许可证文件加载到系统中，请选择 Upload。 

11. 浏览到存储许可证文件的位置，然后选择 Open。
12. 绿色图标指示上传成功。选择 Continue。 
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13. 在成功激活后，将显示一个窗口，列出激活的功能。检查安装的功能是否与您的许可
证相符。 

14. 要退出 License Manager，请选择 Quit。
15. 要完成并验证安装，请重新启动计算机并打开 BL-View：开始 > （ > 所有程序 > ） > 

Vaisala > BL-View > BL-View。
如果激活失败，将会显示失败原因和解决措施。如果您需要进一步帮助，请与维萨拉公司
联系。
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5. 配置
BL-View 通过串行线、TCP/IP 或 UDP 连接来连接到云高仪。
在 BL-View 安装完毕后，即使图形用户界面未打开，该软件也会持续接收数据和对数据进
行分析。
在使用 BL-View 查看和分析来自云高仪的数据前：

1. 请确保云高仪连接到计算机。
有关更多信息，请参见 Vaisala Ceilometer CL31 User Guide 和 Vaisala Ceilometer
CL51 User Guide。

2. 检查云高仪设置是否正确配置。
请参见配置云高仪 (页 25)。

3. 将云高仪的位置参数添加到 BL-View。
请参见将云高仪添加至 BL-View (页 27)。

4. 配置 BL-View 连接设置。
请参见 BL-View 连接设置 (页 30)。

5. 配置消息设置。
请参见配置消息设置 (页 36)。

在您完成了云高仪的添加并且配置了连接设置和消息设置后，重新启动计算机。

5.1 配置云高仪
如果您尚未将云高仪与 BL-View 一起订购，在使用 BL-View 分析云高仪的实时数据前可能
需要更改云高仪设置。

为了获得最佳性能，对于所选的云高仪类型请使用建议的设置。

设置 支持的值 针对 CL31 的推荐值 针对 CL51 的推荐值
数据信息 msg1_10x770 msg2_10x770

如果禁用了天空状况算
法：
msg1_10x770

msg2_10x1540
如果禁用了天空状况算
法：
msg1_10x1540

msg1_20x385
msg1_5x1500
msg1_10x1540
msg2_10x770
msg2_20x385
msg2_5x1500
msg2_10x1540
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设置 支持的值 针对 CL31 的推荐值 针对 CL51 的推荐值
信息间隔 2 … 75 秒 16 秒 36 秒

1. 打开与云高仪的连接。 
请参见打开终端连接 (页 89)。

2. 打开云高仪的通信端口。 
请参见打开和关闭通信端口 (页 90)。

3. 要设置高级命令，请键入： 

advanced

4. 要设置信息格式，请键入： 

set message type <信息格式>

• 例如，对于 CL31：

set message type msg2_10x770

• 例如，对于 CL51：

set message type msg2_10x1540

5. 要设置信息间隔，请键入以下内容： 
• 对于 CL31：

set message interval 16

• 对于 CL51：

set message interval 36
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6. 要启用距离门归一化，请键入： 

set message profile noise_h2 on

距离门数据始终是距离归一化的，包括噪音。
7. 要获取 CL31 的工厂参数，请键入： 

get params factory

8. 检查响应中对应 CL31 的接收器类型。如果接收器类型为 CLR321，请转到下一步。
否则，使用以下命令更改算法参数： 

set factory algo_sensit high_cloud 5

9. 关闭通信端口。 
请参见打开和关闭通信端口 (页 90)。

10. 验证输出信息是正确的。

5.2 将云高仪添加至 BL-View
在您首次启动 BL-View 时或者在具有新的云高仪时，将云高仪信息添加至 BL-View。
此信息用作输出文件中的参数。
BL-View 显示连接了多少台设备以及在许可证中包含多少台设备，例如 2/5 devices 
added（已添加了 2 个设备，共 5 个设备）。

请确保使用您在 BL-View 2.0 和 2.1 中具有的云高仪的相同设置。在卸载以前的软件版
本之前，请参考注释或者您的屏幕截图。

1. 选择 开始 > ( > 所有程序 > ) > Vaisala > BL-View > BL-View。
2. 在 BL-View 中，选择系统 > 设置 > 设备 和 添加。 

如果您无法选择 添加，则可能正在使用您的许可证所允许的所有设备。对于许可证更
新和新许可证，请与维萨拉联系。
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3. 在设备中，设置以下内容： 
设备名称

键入云高仪的描述性名称，例如 CL31 Helsinki。
使用您在 BL-View 2.0 和 2.1 中对于云高仪具有的相同名称。

纬度
键入云高仪的纬度坐标。根据标准 WGS84 提供坐标：-90.0000 ... 90.0000 度，
南、北。
使用您在 BL-View 2.0 和 2.1 中对于云高仪具有的相同名称。

经度
键入云高仪的经度坐标。根据标准 WGS84 提供坐标：-180.0000 ... 180.0000
度，西、东。
使用您在 BL-View 2.0 和 2.1 中对于云高仪具有的相同名称。

海拔高度
键入云高仪位置的纬度。分辨率采用整米和整英尺。对于低于海平面的值，使
用负数，例如 -5。
您还可以忽略此设置并且将该值保留为默认值 0。

UTC 偏移
选择云高仪位置的时区。
使用您在 BL-View 2.0 和 2.1 中对于云高仪具有的相同名称。

WMO 观测站编号（可选）
键入观测站编号，该观测站编号由 WMO 块号（2 位）和观测站编号（3 位）构
成。
使用您在 BL-View 2.0 和 2.1 中对于云高仪具有的相同名称。
如果您正在从 BL-View 2.0 迁移，则查看来自 netCDF 文件名“观测站名称”
(L2_<STATION_NAME>_YYYYMMDDHHMM_<FREE_FORMAT>.nc) 的信息。
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4. 在数据中，设置以下内容： 
文件后缀（可选）

定义添加到 netCDF 文件名末尾的文本。
使用您在 BL-View 2.0 和 2.1 中具有的相同文本。
如果您正在从 BL-View 2.0 迁移，则查看来自 netCDF 文件名“自由格式”
(L2_<STATION_NAME>_YYYYMMDDHHMM_<FREE_FORMAT>.nc) 的信息。

文件路径
要定义存储 netCDF 文件的位置，请选择 浏览...。默认位置为
C:\BLViewData。在此目录中为指定的设备名称创建一个文件夹。

5. 配置连接和信息设置。
6. 选择 保存和 关闭。
7. 在您完成了云高仪的添加并且配置了连接设置和消息设置后，重新启动计算机。

云高仪信息显示在 BL-View 中，并且 BL-View 开始将数据收集到 HIS 文件和 netCDF 文
件。
更多信息
‣ BL-View 连接设置 (页 30)
‣ 配置消息设置 (页 36)
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5.3 BL-View 连接设置
以下连接类型可用于将 BL-View 连接到云高仪：

• 串行线路连接
• UDP 连接
• TCP/IP 连接（客户端或服务器）

请确保使用您在 BL-View 2.0 和 2.1 中具有的云高仪的相同设置。在卸载以前的软件版
本之前，请参考注释或者您的屏幕截图。

5.3.1 配置串口线连接
选择用于与云高仪进行串行通信的设置。

1. 在 BL-View 中，选择系统 > 设置 > 设备。
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2. 在连接中，设置以下内容： 
连接类型

选择串行。
波特率

设置波特率。选项为 9600、19200、38400、57600 和 115200。
串行端口号

选择要与云高仪进行通信的 COM 端口。可用范围是 COM1 ... COM20。
数据位

设置要使用的数据位数。可用范围是 5 … 9。默认值为 8。
停止位

设置要使用的停止位数。可用范围是 0 … 4。默认值为 1。
奇偶校验

选择奇偶校验。选项为无、奇数、偶数、标记或空格。
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3. 配置消息设置。
4. 选择 保存和 关闭。

更多信息
‣ 配置消息设置 (页 36)

5.3.2 配置 UDP 连接
选择用于与云高仪进行 UDP 通信的设置。

1. 在 BL-View 中，选择系统 > 设置 > 设备。
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2. 在连接中，设置以下内容： 
连接类型

选择 UDP。
本地端口

您的计算机上的端口。
设备 IP 地址

云高仪 IP 地址。选择以便匹配云高仪中的设置。
设备端口

云高仪端口号。

3. 配置消息设置。
4. 选择 保存和 关闭。
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更多信息
‣ 配置消息设置 (页 36)

5.3.3 配置 TCP/IP 连接
BL-View 支持远程连接到云高仪。选择用于与云高仪进行 TCP/IP 通信的设置。

1. 在 BL-View 中，选择系统 > 设置 > 设备。
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2. 在连接中，设置以下内容： 
连接类型

选择 TCP 服务器或 TCP 客户端。如果您将 BL-View 设置为 TCP 服务器，则只
需指定本地端口。

本地端口
您的计算机上的端口。

设备 IP 地址
云高仪 IP 地址。选择以便匹配云高仪中的设置。

设备端口
云高仪端口号。

3. 配置消息设置。
4. 选择 保存和 关闭。
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更多信息
‣ 配置消息设置 (页 36)

5.4 配置消息设置
请确保使用您在 BL-View 2.0 和 2.1 中具有的云高仪的相同设置。在卸载以前的软件版
本之前，请参考注释或者您的屏幕截图。

1. 在 BL-View 中，选择系统 > 设置 > 设备。
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2. 在信息中，设置信息类型。 
该值必须匹配为云高仪设置的信息格式。

设置 支持的值 针对 CL31 的推荐值 针对 CL51 的推荐值
数据信息 msg1_10x770 msg2_10x770

如果禁用了天空状况算
法：
msg1_10x770

msg2_10x1540
如果禁用了天空状况算
法：
msg1_10x1540

msg1_20x385
msg1_5x1500
msg1_10x1540
msg2_10x770
msg2_20x385
msg2_5x1500
msg2_10x1540
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设置 支持的值 针对 CL31 的推荐值 针对 CL51 的推荐值
信息间隔 2 … 75 秒 16 秒 36 秒

3. 在数据传输间隔中，设置信息时间间隔（以秒为单位）。
4. 选择 保存和 关闭。

5.5 验证设置
在您安装并且配置了新的 BL-View 版本后，对设置进行验证。

1. 检查 BL-View 是否开始接收数据。 
netCDF 文件的默认存储位置为 C:\BLViewData。
每个设备都基于在系统 > 设置 > 设备中定义的设备名称对于文件具有单独的文件夹。
HIS 文件的存储位置为：

• C:\BLView\History\<year>\<month>（自动生成的文件）
• C:\Program Files (x86)\Vaisala\BL-View\bin\History\<month>

（手动生成的文件/导出的文件）

5.6 获取使用其他 BL-View 版本收集的数据
要获取和显示使用以前的 BL-View 版本收集的数据：

• BL-View 中的设备、数据、连接和信息设置必须匹配 netCDF 文件中的信息。
• netCDF 文件需要处于特定文件夹中。

可获取的数据为级别 2 (L2) 数据。
1. 找到使用以前的 BL-View 版本收集的文件，然后将这些文件复制到/移到

C:\BLViewData 下的正确的设备文件夹中。 
对于每个云高仪都提供有子文件夹。根据在系统 > 设置 > 设备中定义的设备名称命名
这些文件夹。
使用云高仪名称作为文件夹名称。
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2. 在 BL-View 中，检查系统 > 设置 > 设备中的设置。 
这些设备必须与您已复制/移动的 BL-View 文件中的信息匹配。
对于 文件路径，浏览到您复制了 netCDF 文件的文件夹。默认位置为
C:\BLViewData。

3. 确认 BL-View 可以打开这些文件。在 BL-View 中，依次选择添加图、归档以及某个日
期。选择您知道具有数据的某个日期。 
如果 BL-View 未打开该文件，请确保您在以前的 BL-View 版本和当前 BL-View 版本
中具有相同的设置（系统 > 设置 > 设备）。

在与其他用户共享 L2 netCDF 文件时，请确保检查以下信息在系统中和这些文件中匹配：
• 设备名称
• 纬度和经度
• UTC 偏移量
• WMO 观测站编号/名称
• 文件后缀
• 文件存储位置（文件路径）
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6. 功能介绍
6.1 数据输入
BL-View 支持以下文件类型：

• 维萨拉 BL-View netCDF 文件
• 维萨拉 CL-VIEW DAT 文件

您可以使用文件管理器将现有 L2 和 L3 netCDF 文件引入 BL-View 并且打开数据以便在
BL-View 中查看。
您可以将现有 DAT 文件导入到 BL-View。为在 BL-View 中查看数据，该服务将这些数据转
换为 netCDF 格式。

图 4 BL-View 导入数据

更多信息
‣ 访问 netCDF 文件 (页 87)
‣ 查看归档数据 (页 59)
‣ 导入数据（DAT 文件） (页 82)
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6.2 工作模式
您可以在 BL-View 中查看实时数据和归档数据。
BL-View 在绘制数据时使用 16 秒消息间隔。
可用的海拔高度单位为米 (m) 和英尺 (ft)。

6.2.1 归档数据
您可以访问来自云高仪的归档数据。
您可以根据默认或自定义参数集对数据进行分析。
BL-View 自动将数据存储到 netCDF 文件。

图 5 BL-View 归档数据

更多信息
‣ 查看归档数据 (页 59)
‣ NetCDF 文件 (页 46)

6.2.2 实时数据
您可以访问来自云高仪的实时数据。
只要您将 BL-View 连接到某一云高仪，BL-View 就会基于默认参数收集数据。即使您未在
使用 BL-View，BL-View 也会收集数据。默认情况下，BL-View 会根据默认显示参数处理
数据。
您可以创建自定义的参数集。对于它们，BL-View 将在您具有打开的图时存储数据。

BL-View 用户指南 M211185ZH-D

42



BL-View 自动将数据存储到 netCDF 文件。
• netCDF L1 数据文件包含来自云高仪的级别 1 (L1) 数据。
• netCDF L2 数据文件包含经历了预先计算服务和求平均值的级别 2 (L2) 数据。
• netCDF L3 数据文件包含经历了计算服务的级别 3 (L3) 数据并且包含来自算法的所有

数据，包括混合层高度值和质量指数数据。

图 6 BL-View 实时数据和数据输出

更多信息
‣ 查看实时数据 (页 58)
‣ 数据输出 (页 43)

6.3 数据输出
BL-View 支持创建若干文件类型。

6.3.1 图像文件 (PNG)
BL-View 支持从屏幕上的数据创建图像文件。
您可以轻松地将该视图保存在 PNG 图像文件中。
保存的图像将在图像顶部显示设备名称、日期以及与所使用的算法有关的信息。
更多信息
‣ 屏幕瞬时截图（PNG 文件） (页 83)
‣ 计划快照（PNG 文件） (页 84)

6.3.2 HIS 文件 (ASCII)
HIS 文件是包含 ASCII 格式的策略数据的日志文件。
HIS 文件是为级别 2 (L2) 和级别 3 (L3) 数据自动生成的。手动生成的 HIS 文件包含级别 3
数据。

章节 6 – 功能介绍

43



表 4 HIS 文件
His 文件属性 自动生成的文件 手动生成的文件（导出）
数据 级别 2、级别 3 级别 3
预设 默认和所有现有预设（每个预设的单独文

件）
用户可选择的预设

存储位置 C:\BLView\History\<year>
\<month>

C:\Program Files (x86)\Vaisala
\BLView\bin\History\<month>

文件名的格式为 <CEILOMETER_NAME>_<DATA_LEVEL>_<PRESET>_<DD>.his。
文件名示例：CEILOMETER_1_LEVEL_2_DEFAULT_27.his.
表 5 HIS 文件名的字段

名称 说明 值
CEILOMETER_NAME 在云高仪中定义的云高仪标识符 CEILOMETER_1
DATA_LEVEL 数据级别的标识 LEVEL_2
PRESET 算法信息（仅限 L3 文件） DEFAULT
DD 日期 27

表 6 级别 2 HIS 文件
属性 说明
CREATEDATE 格式为 YYYY-MM-DD hh:mm:ss (UTC) 的时间戳
UNIXTIME 时间戳（UTC 时间）
CEILOMETER 云高仪标识符
PERIOD 数据更新期间（以秒为单位）
BS_PROFILE 以分辨率 10 和 4500 米（14760 英尺）的高度呈现的信号后向散射廓

线

表 7 级别 3 HIS 文件
属性 说明
CREATEDATE 格式为 YYYY-MM-DD hh:mm:ss (UTC) 的时间戳
UNIXTIME 时间戳（UTC 时间）
CEILOMETER 云高仪标识符
PERIOD 数据更新期间（以秒为单位）
SAMPLE_COUNT 用于计算此级别 3 的级别 2 的样本数
BL_HEIGHT_1 第一个边界层高度候选项（米）（如果没有候选项则为 -999）
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属性 说明
BL_HEIGHT_2 第二个边界层高度候选项（米）（如果没有候选项则为 -999）
BL_HEIGHT_3 第三个边界层高度候选项（米）（如果没有候选项则为 -999）
BL_INDEX_1 第一个边界层高度候选项（米）的质量指数（如果没有候选项则为

-999）
BL_INDEX_2 第二个边界层高度候选项（米）的质量指数（如果没有候选项则为

-999）
BL_INDEX_3 第三个边界层高度候选项（米）的质量指数（如果没有候选项则为

-999）
MEAN_LAYER_HEIGHT 每小时平均混合层高度
MEAN_LAYER_INDEX 每小时平均混合层高度的质量指数
CLOUD_STATUS 云探测状态，0 - 4
CLOUD_1 第一个云底（米）或垂直可见度（米）（如果没有云底或垂直可见度则

为 -999）
CLOUD_2 第二个云底（米）或垂直可见度（米）中接收的最高信号（如果没有云

底或垂直可见度则为 -999）
CLOUD_3 第三个云底（米）（如果没有云底则为 -999）
PARAMETERS 级别 2 到级别 3 算法参数

这里是具有自定义参数的级别 3 HIS 文件的示例。

History file
CREATEDATE, UNIXTIME, CEILOMETER, PERIOD, SAMPLE_COUNT, BL_HEIGHT_1, BL_HEIGHT_2, 
BL_HEIGHT_3, BL_INDEX_1, BL_INDEX_2, BL_INDEX_3, MEAN_LAYER_HEIGHT, MEAN_LAYER_INDEX, 
CLOUD_STATUS, CLOUD_1, CLOUD_2, CLOUD_3, PARAMETERS
2018-04-23 00:00:00, 1524441600, CL31 - C2, 16, 82, 70, 320, 600, 2, 1, 2, 83, 1, 1, 7405, -999, -999, 
1_360_1_3120_10_30_4000_3_0_1_500_1000_4000_60
2018-04-23 00:00:16, 1524441616, CL31 - C2, 16, 81, 70, 320, 600, 2, 1, 2, 83, 1, 1, 7445, -999, -999, 
1_360_1_3120_10_30_4000_3_0_1_500_1000_4000_60
2018-04-23 00:00:32, 1524441632, CL31 - C2, 16, 81, 70, 320, 600, 2, 1, 2, 83, 1, 1, 7405, -999, -999, 
1_360_1_3120_10_30_4000_3_0_1_500_1000_4000_60

属性 说明/数值
CREATEDATE 2018-02-28 22:00:00
UNIXTIME 1519855200
CEILOMETER HelsinkiNE
PERIOD  
SAMPLE_COUNT 82
BL_HEIGHT_1 350
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属性 说明/数值
BL_HEIGHT_2 -999（无候选项）
BL_HEIGHT_3 -999（无候选项）
BL_INDEX_1 3
BL_INDEX_2 -999（无候选项）
BL_INDEX_3 -999（无候选项）
MEAN_LAYER_HEIGHT 190
MEAN_LAYER_INDEX 3
CLOUD_STATUS 0
CLOUD_1 -999（没有云底或垂直可见度）
CLOUD_2 -999（没有云底或垂直可见度）
CLOUD_3 -999（没有云底）
PARAMETERS 1_360_1_3120_10_30_4000_3_0_1_500_1000_4000_60

更多信息
‣ 导入数据（HIS 文件） (页 86)

6.3.3 NetCDF 文件
网络通用数据格式 (netCDF) 是一组软件库和自我描述的、独立于机器的数据格式，支持
面向阵列的科学数据的创建、访问和共享。
BL-View 中的 netCDF 服务遵循级别 1 (L1)、级别 2 (L2) 和级别 3 (L3) 数据。每隔 16、30
或 36 秒发生的测量和计算事件触发服务以便读取 L1、L2 和 L3 字段，并且将数据写入相
应 netCDF 文件。
对于每个已连接设备，该服务将每隔 24 小时创建以下文件：

• 对于 L1 数据 1 个 netCDF 文件
• 对于 L2 数据 1 个 netCDF 文件
• 对于具有默认配置文件设置的 L3 数据 1 个 netCDF 文件
• 或者，如果已配置：对于具有自定义配置文件设置的 L3 数据的 netCDF 文件（每个

自定义设置 1 个文件）
netCDF 文件的扩展名为 .nc。netCDF 文件的默认存储位置为 C:\BLViewData。每台设
备都具有针对这些文件的单独文件夹。
维萨拉建议定期备份 netCDF 文件。
级别 3 (L3) netCDF 文件的示例位于 BL-View NetCDF Example File Technical Reference
中。
更多信息
‣ 访问 netCDF 文件 (页 87)
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6.3.3.1 NetCDF L1 文件格式
netCDF L1 数据文件包含来自云高仪的级别 1 (L1) 数据。
NetCDF L1 文件名具有以下格式：
L1_<STATION_NUMBER>_YYYYMMDDHHMM_<FREE_FORMAT>.nc

表 8 L1 文件名的字段
名称 说明
L1 数据级别的标识
STATION_NUMBER WMO 观测站编号（如果已在系统 > 设置 > 设备中定义）。
YYYYMMDDHHMM UTC 时间
FREE FORMAT 文件后缀（如果已在系统 > 设置 > 设备中定义）。

示例：L1_201609290722

使用了以下全局属性：
• site_location
• instrument_type

表 9 L1 维度
维度名称 说明
time 廓线数
range 垂直单元数

表 10 NetCDF L1 数据文件字段
变量名称 属性 说明
time Units = 天

Type = 双精
度
Dimension
= 时间
axis = T

Unix 时间

name Dimension
= 时间

数据标识符（云高仪名称），由系统 > 设置 > 设备定义

range Dimension
= 范围

7700 米（25260 英尺），分辨率为 10 米（33 英尺）的值，
这意味着 770 个样本

message_type Dimension
= 时间

云高仪数据信息类型（11、12、13、16、21、22、23 或
26）

version Dimension
= 时间

云高仪版本号
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变量名称 属性 说明
date_stamp Units = 天

Type = 双精
度
Dimension
= 时间
axis = T

文本格式的测量时间戳 (yyyy-MM-dd hh:mm:ss)

period Dimension
= 时间

云高仪数据信息的发送频率（毫秒）。
针对 16 秒的信息间隔对边界层高度算法进行了优化。

tilt_angle Units = 度
Type = 整数
Dimension
= 时间

云高仪倾斜角度（0 ... 90 度）。

cloud_status Dimension
= 时间

0 = 无显著后向散射/存在一些遮蔽但确定为通透
1 = 一个云层
2 = 两个云层或完全遮蔽（检测到垂直能见度和最大信号）
3 = 三个云层
4 = 将云状态更改为 2，报告垂直能见度和最大信号

cloud_data Dimension
= 时间

检测到云底或垂直能见度/最大信号（米或英尺）

status_bits Dimension
= 时间

云高仪状态位（12 个字符）

profile_scale Dimension
= 时间

云高仪信号后向散射廓线的缩放参数（0 ...9999，100 = 不
缩放）

profile_resolution Dimension
= 时间

云高仪信号后向散射廓线的分辨率（5、10 或 20 米（16、
33 或 66 英尺），取决于信息类型）

profile_length Dimension
= 时间

云高仪信号后向散射廓线中的样本数（385、770 或
1540），取决于信息类型

rcs_910 Dimension
= 时间, 范围

云高仪信号后向散射廓线
使用 20 位十六进制 ASCII 字符集对每个样本进行编码

6.3.3.2 NetCDF L2 文件格式
netCDF L2 数据文件包含经历了预先计算服务和求平均值的级别 2 (L2) 数据。
将廓线设置为 4500 米（14764 英尺）。
NetCDF L2 文件名具有以下格式：
L2_<STATION_NUMBER>_YYYYMMDDHHMM_<FREE_FORMAT>.nc

表 11 L2 文件名的字段
名称 说明
L2 数据级别的标识
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名称 说明
STATION_NUMBER WMO 观测站编号（如果已在系统 > 设置 > 设备中定义）。
YYYYMMDDHHMM UTC 时间
FREE_FORMAT 文件后缀（如果已在系统 > 设置 > 设备中定义）。

示例：L2_201609290722

表 12 L2 维度
维度名称 说明
time 廓线数
range 垂直单元数

表 13 NetCDF L2 数据文件字段
变量名称 属性 说明
time Units = 天

Type = 双精度
Dimension = 时间
axis = T

Unix 时间

name Dimension = 时间 数据标识符（云高仪名称），由系统 > 设置 > 设备定
义

version Dimension = 时间 云高仪版本号
date_stamp Units = 天

Type = 双精度
Dimension = 时间
axis = T

文本格式的测量时间戳 (yyyy-MM-dd hh:mm:ss)

range Dimension = 范围 4500 米（14764 英尺），分辨率为 10 米（33 英
尺）的值，这意味着 450 个样本

period Dimension = 时间 云高仪数据信息的发送频率（秒）
cloud_status Dimension = 时间 0 = 无显著后向散射/存在一些遮蔽但确定为通透

1 = 一个云层
2 = 两个云层或完全遮蔽（检测到垂直能见度和最大
信号）
3 = 三个云层

cloud_data Dimension = 时间 检测到云底或垂直能见度/最大信号（米或英尺）
status_bits Dimension = 时间 云高仪状态位（12 个字符）
profile_length Dimension = 时间 云高仪信号后向散射廓线中的样本数 (450)

章节 6 – 功能介绍
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变量名称 属性 说明
bs_std Dimension = 时间 云高仪信号后向散射廓线的标准差，从以下高度范围

计算而来：6210 ... 6700 米或 7210 ... 7700 米
（20374 ... 21982 英尺或 23655 ... 25260 英尺）

profile_data Dimension = 时间, 范围 云高仪信号后向散射廓线（10 米/33 英尺分辨率，
450 个样本，直到达到高度 4500 米 / 14764 英尺）

longitude Dimension = 时间 每个测量值的经度。基于云高仪位置，由系统 > 设
置 > 设备定义

latitude Dimension = 时间 每个测量值的纬度。基于云高仪位置，由系统 > 设
置 > 设备定义

altitude Dimension = 时间 距海平面的海拔高度。基于云高仪位置，由系统 > 设
置 > 设备定义

utc_offset Dimension = 时间 UTC 偏移量

6.3.3.3 NetCDF L3 文件格式
netCDF L3 数据文件包含经历了计算服务的级别 3 (L3) 数据并且包含来自算法的所有数
据，包括混合层高度值和质量指数数据。
有 3 种不同的 L3 文件类型：

• L3 默认文件：此文件包含 L3 数据，后者将默认预设用于实时图。
• L3 自定义文件：此文件包含 L3 数据，后者将自定义预设用于实时图。
• L3 归档文件：此文件包含来自归档图的 L3 数据。

NetCDF L3 文件名具有如下表中所示的格式。
表 14 NetCDF L3 文件的命名

L3 文件类型 文件名
具有默认廓线设置的 L3 L3_DEFAULT_<STATION_NUMBER>_YYYYMMDDHHMM_<Parameter

Key>_<FREE_FORMAT>.nc

具有自定义廓线设置的 L3 L3_CUSTOM_<STATION_NUMBER>_YYYYMMDDHHMM_<ParameterK
ey>_<FREE_FORMAT>.nc

归档图的 L3 L3_OFFLINE_<STATION_NUMBER>_YYYYMMDDHHMM_<Parameter
Key>_<FREE_FORMAT>.nc

表 15 L3 文件名的字段
名称 说明
L3 数据级别的标识
DEFAULT L3 文件类型的标识
CUSTOM

OFFLINE

STATION_NUMBER WMO 观测站编号（如果已在系统 > 设置 > 设备中定义）。
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名称 说明
YYYYMMDDHHMM UTC 时间
ParameterKey 高级算法设置的标识。有关说明，请参见下表。
FREE_FORMAT 文件后缀（如果已在系统 > 设置 > 设备中定义）。

示例文件名：
L3_DEFAULT_06610_201701160000_1_360_1_3120_10_30_4000_3_0_1_500_1
000_4000_60.nc

示例参数键：

1_360_1_3120_10_30_4000_3_0_1_500_1000_4000_60

表 16 参数键中的计算参数
参数 说明 示例值
自动高度平均 0 = 否

1 = 是
1

高度平均间隔（自动：最大高度平
均间隔）

默认值为 360 米（1181 英尺）。 360

自动时间平均 0 = 否
1 = 是

1

时间平均间隔（秒）（自动：最大
时间平均间隔（秒））

可用范围是 60 ... 3000 秒。默认值
为 3000。

3120

算法灵敏度 可用范围是 0 … 20。默认值为 5。 10
边界层最小值 可用范围是 30 … 500 米

（99 … 1640 英尺）。默认值为
30 米（99 英尺）。

30

边界层最大值 可用范围是 200 … 4000 米
（656 ... 13120 英尺）。默认值为
4000 米（13120 英尺）。

4000

边界层数 可用范围是 1 … 3。默认值为 3。 3
算法方法 0 = 合并式

1 = 梯度
2 = 廓线拟合

0

廓线拟合设置
SNR 可用范围是 0 … 100。默认值为

1。
1

SNR 平均窗口 可用范围是 20 … 1000 米（66 ...
3280 英尺）。默认值为 500 米
（1640 英尺）。

500

章节 6 – 功能介绍

51



参数 说明 示例值
夜间模式长度 可用范围是 10 … 4500 米（33 ...

14760 英尺）。默认值为 1000 米
（3280 英尺）。

1000

日间模式长度 可用范围是 10 … 4500 米（33 ...
14760 英尺）。默认值为 4000 米
（13120 英尺）。

4000

剔除异常值强度 可用范围是 0 … 500。默认值为
60。

60

使用了以下 global attribute：
• site_location

表 17 L3 维度
维度名称 说明
time 廓线数
range 垂直单元数

表 18 NetCDF L3 数据文件字段
变量名称 属性 说明
time Units = 天

Type = 双精度
Dimension =
时间
axis = T

Unix 时间

name Dimension =
时间

数据标识符（云高仪名称），由系统 > 设置 > 设备定
义

date_stamp Units = 天
Type = 双精度
Dimension =
时间
axis = T

文本格式的测量时间戳 (yyyy-MM-dd hh:mm:ss)

period Dimension =
时间

云高仪数据信息的发送频率（秒）

Mean_Layer_Height Dimension =
时间

1 小时期间的平均混合层高度

Mean_Layer_QualityIndex Dimension =
时间

1 小时期间的平均混合层质量指数

Mean_Layer_Calculation_Ti
me

Dimension =
时间

1 小时间隔的平均层计算时间
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变量名称 属性 说明
cloud_status Dimension =

时间
0 = 无显著后向散射/存在一些遮蔽但确定为通透
1 = 一个云层
2 = 两个云层或完全遮蔽（检测到垂直能见度和最大
信号）
3 = 三个云层

cloud_data Dimension =
时间

检测到云底或垂直能见度/最大信号（米或英尺）

bl_height_length Dimension =
时间

找到的边界层高度候选项数 (0 ... 3)

bl_index Dimension =
时间

边界层高度候选项的质量指数

bl_height Dimension =
时间

边界层高度候选项（米）

Bs_profile_length Dimension =
时间

云高仪信号后向散射廓线中的样本数 (450)

bs_profile_data Dimension =
时间, 范围

云高仪信号后向散射廓线（10 米/33 英尺分辨率，
450 个样本，直到达到高度 4500 米 / 14764 英尺）

Ng_profile_length Dimension =
时间

负梯度廓线中的样本数 (450)

ng_profile_data Dimension =
时间, 范围

负梯度廓线（10 米/33 英尺分辨率，450 个样本，直
到达到高度 4500 米 / 14764 英尺）

Ec_profile_length Dimension =
时间

云高仪信号消光系数廓线中的样本数 (450)

ec_profile_data Dimension =
时间, 范围

消光系数 (EC) 廓线（10 米/33 英尺分辨率，450 个
样本，直到达到高度 4500 米 / 14764 英尺）

Ec_profile_range Dimension =
时间

消光系数 (EC) 廓线数据有效的范围（米）。该范围
之上的数据为 0

Ec_profile_opacity Dimension =
时间

0.01 单位中消光系数 (EC) 廓线的不透明度（或气溶
胶光学厚度，AOD）；它是至该范围 EC 的积分值

vrb_height_averaging Dimension =
时间

1 = True，使用变化高度平均（默认）
0 = False，使用用户定义的常量高度平均

vrb_time_averaging Dimension =
时间

1 = True，使用变化时间平均（默认）
0 = False，使用用户定义的常量时间平均

Height_averaging_param Dimension =
时间

高度平均参数（40 ... 600 米，默认值为 360 米 /
131 ... 1969 英尺，默认值为 1181 英尺）
仅当 vrb_height_averaging = false 时使用

Time_averaging_period Dimension =
时间

时间平均时段（60 ... 3000 秒，默认值为 3000）
仅当 vrb_time_averaging = false 时使用

章节 6 – 功能介绍

53



变量名称 属性 说明
algorithm_sensitivity Dimension =

时间
算法灵敏度（0 ... 20，默认值为 10）
值越小表示灵敏度越高

boundary_layer_min Dimension =
时间

边界层高度候选项的最小高度（30 ... 500 米，默认
值为 30 米 / 99 ... 1640 英尺，默认值为 99 英尺）

boundary_layer_max Dimension =
时间

边界层高度候选项的最大高度（200 ... 4000 米，默
认值为 4000 米 / 656 ... 13123 英尺，默认值为
13123 英尺）

number_of_boundary_layers Dimension =
时间

要报告的最大边界层高度候选项数（0 ... 3，默认值
为 3）

Location_latitude Dimension =
时间

每个测量值的纬度。基于云高仪位置，由系统 > 设
置 > 设备定义

Location_longitude Dimension =
时间

每个测量值的经度。基于云高仪位置，由系统 > 设
置 > 设备定义

location_utc_offset Dimension =
时间

每个测量值的 UTC 偏移量。基于云高仪位置，由系
统 > 设置 > 设备定义

Algorithm_Method Dimension =
时间

0 = 合并式梯度和廓线拟合
1 = 梯度
2 = 廓线拟合

parameter_key Dimension =
时间

请参见表 16 (页 51)。

sunrise_utc Dimension =
时间

UTC 日出时间（小时）

sunset_utc Dimension =
时间

UTC 日落时间（小时）

LevelTwoCount  用于创建级别 3 (L3) 样本的级别 2 (L2) 的样本数
range Dimension =

范围
4500 米（14764 英尺），分辨率为 10 米（33 英
尺）的值，这意味着 450 个样本
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7. 使用 BL-View
7.1 使用 BL-View
BL-View 提供不同的数据视图，例如后向散射和负梯度视图，并且很容易就可以过滤掉数
据以便仅强调边界层高度、云数据高度和/或强度信息。BL-View 根据指定的设置绘制边界
层和云底数据。使用实时和归档图选项和调整算法设置（计算预设）。

7.2 打开 BL-View
1. 要打开 BL-View，请选择开始 > （ > 所有程序 > ） > Vaisala > BL-View > BL-

View。 
BL-View 打开并显示实时数据。

7.3 选择显示设置
您可以选择显示语言以及 BL-View 中的数据以米还是以英尺显示。
该选择不影响 HIS 和 netCDF 文件中的数据，它们始终以英语和以米为单位显示。

1. 在 BL-View 中，选择系统 > 设置 > 显示。

章节 7 – 使用 BL-View
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2. 在 默认单位中，选择希望 BL-View 中的数据以米还是以英尺显示。 
单位设置应用于 BL-View 中的显示数据。

3. 选择语言。
4. 选择关闭。
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8. 使用图形
8.1 读取图形
在 BL-View 中，边界层信息在屏幕上用密度图来表示。您可以创建图来查看和分析实时数
据和归档数据。每个新图作为新选项卡打开。
右侧面板显示以下信息：

• 数据允许选择混合层高度数据（MLH 数据）和 廓线数据。
• 对于实时图：当前值显示当前打开的密度图中的边界层和云底高度。
• 对于归档图：图例显示边界层和云底标记。不提供高度信息。
• 强度显示后向散射或负梯度视图中显示的边界层信息的强度标度。
• 导航器显示当前显示图的哪一部分。
• 信息显示所选算法参数和更新状态。

如果您选择查看廓线数据，当前值 / 图例只显示云底信息，信息不显示算法信息。

图形中使用以下标记：
• 深红/黄/绿色矩形：边界层高度。这些颜色指示数据的质量。
• 蓝线：1 小时平均混合层高度。
• 灰色矩形：其他边界层高度（升高的层）。
• 蓝点：云底高度。

章节 8 – 使用图形
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图 7 BL-View 面板：归档图

8.1.1 查看实时数据
您可以创建密度图以便查看来自云高仪的实时数据。

对于每个云高仪，您可以同时查看 1 个默认实时图和 1 个自定义实时图。

1. 在 BL-View 中，选择添加图。
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2. 设置以下属性： 
图

选择实时。
预设

选择预设（算法参数集）以便对数据进行分析。

3. 选择确定。 

在实时数据显示在 BL-View 中之前可能有 1 分钟的延迟。

具有以下名称的图将打开：Live-<预设名称>。实时图在名称的前方具有一个绿色圆圈。
如果您想要查看具有不同预设的图，则首先检查您是否具有可用预设或创建预设（系统 > 
设置 > 预设）。之后，使用该预设添加图。
更多信息
‣ 实时数据 (页 42)
‣ 管理计算预设 (页 68)

8.1.2 查看归档数据
您可以创建密度图以便查看已归档数据。

1. 在 BL-View 中，选择添加图。
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2. 在图中，在日历中选择归档以及月份和日期。 

3. 在预设中，选择预设（算法参数集）以便对数据进行分析。
4. 选择 确定。

具有以下名称的图将打开：<日期>-<预设名称>。归档图在名称的前方具有一个灰色圆
圈。
如果您想要查看具有不同预设的图，则首先检查您是否具有可用预设或创建预设（系统 > 
设置 > 预设）。之后，使用该预设添加图。
更多信息
‣ 归档数据 (页 42)
‣ 管理计算预设 (页 68)

8.1.3 缩放图
您可以更改正在查看的图的时间和高度范围设置。

1. 选择要修改的图的选项卡。
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2. 使用鼠标来放大。缩放限制为 3 小时和 200 米（656 英尺）。 

时间范围为 9 小时或更少时，网格显示所选范围中的所有小时。时间范围为 12 ...
24 时，网格显示所选范围中的每第三个小时。

参数 CL31 CL51
测量范围，MLH 数据 0 ... 4000 米（0 ... 13120 英尺） 0 ... 4000 米（0 ... 13120 英尺）
测量范围，廓线数据 0 ... 7700 米（0 ... 25260 英尺） 0 ... 15400 米（0 ... 50520 英

尺）
3. 要缩小，请右键单击并选择 适合视图。
4. 您还可以显示/隐藏网格并刷新视图。右键单击该图，选择 栅格或 刷新。

8.1.4 读取边界层和云检测图
您可以在图中显示和隐藏 层高度和 云底高度数据。

1. 要查看边界层和云底高度数据，请查看 当前值/图例，它包括： 
• 混合层:混合层的高度
• 1 小时平均值:1 小时平均混合层高度。该信息每小时更新一次。
• 升高的层 1 和 升高的层 2：升高的气溶胶层
• 云底高度:云底 1、2 和 3 的高度
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2. 要查看层高度数据，请选择 MLH 数据。 

在实时图中，如果未正确测量有效参数，则使用 2 个斜杠字符 (//) 替代参数值。

1 日出指示器（黄色）
2 日落指示器（黑色）
3 边界层高度（深红/黄/绿色）和升高的层（灰色）
4 来自云和降水的信号（红色）
5 气溶胶后向散射信号（淡蓝色到黄色）
6 云底高度（蓝点）
7 1 小时平均混合层高度（蓝线）
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3. 要查看包含云底数据的整个廓线，请选择 廓线数据。 
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4. 要查看包含云底数据且不含强度的整个廓线，请选择 廓线数据并禁用 强度。 
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8.1.5 读取云强度图
强度信息指示后向散射或负梯度信号的强度。您可以在图中显示和隐藏强度数据。

1. 要查看强度数据，请启用 强度并选择 后向散射或 负梯度。 

章节 8 – 使用图形

65



2. 要只查看层高度和强度信息（不含云底信息），请禁用 云底高度。 

8.1.6 使用后向散射视图
您可以选择在 BL-View 的后向散射视图中查看云高仪数据。
使用后向散射视图用于对大气边界层结构的一般分析。强度图例中的颜色以 10-9 m-1 sr-1
为单位指示后向散射信号的强度。
对于实时数据，后向散射配置文件每分钟更新。

1. 在数据面板中，启用 MLH 数据。
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2. 在强度面板中，启用强度并且选择后向散射。 

后向散射视图使用以下颜色：
• 图中的红色：来自云和降水的信号。
• 图中的浅蓝色到黄色：气溶胶后向散射信号。

算法设置不会影响显示的云底高度，因为这些计算是在云高仪中执行的。

固定对数标度提供最佳信号动态，并且更易于比较来自不同日期的结果。
后向散射视图显示使用所选算法参数呈现的廓线。云和降水过滤器始终适用。
更多信息
‣ 管理计算预设 (页 68)
‣ 云和降水过滤器 (页 14)

8.1.7 使用负梯度视图
您可以选择在 BL-View 的负梯度视图中查看云高仪数据。
使用负梯度视图可以对混合高度执行详细分析。

1. 在数据面板中，启用 MLH 数据。
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2. 在强度面板中，启用强度并且选择负梯度。 

负梯度视图使用以下颜色：
• 图中的红色：云或降水中强信号降低。
• 图中的浅蓝色到黄色：负梯度信号。

强度图例中的颜色以任意内部单位指示负梯度信号的强度。与显示梯度密度图相比，这提
供针对所有本地梯度最小值的更好的视图。

不是所有本地梯度最小值都有资格作为边界层高度。

更多信息
‣ 管理计算预设 (页 68)

8.2 管理计算预设
预设是在计算中使用的一组算法参数。对于实时图，信息面板显示当前打开的密度图的预
设值。
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图 8 BL-View 算法设置

您可以通过几种方式管理计算预设。

8.2.1 创建计算预设
您可以创建要在图中使用的计算预设。

保存新预设和已编辑的预设将关闭除实时默认图之外所有打开的图，并且重置视图。

1. 在 BL-View 中，选择系统 > 设置 > 预设。
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2. 要创建新预设，请选择新建，键入名称，然后选择确定。 
在设置窗口中，设置以下内容：

算法方法
选择合并式、梯度和廓线拟合、梯度或廓线拟合。

高级算法设置
有关修改高级算法设置的信息，请参见修改计算预设的算法设置 (页 74)。

边界层最小值
设置报告的最低边界层高度。可用范围是 30 … 500 米（99 … 1640 英尺）。默
认值为 30 米（99 英尺）。

边界层最大值
设置报告的最高边界层高度。可用范围是 200 … 4000 米（656 ... 13120 英
尺）。默认值为 4000 米（13120 英尺）。

边界层数
设置在 BL-View 中显示的最多边界层数。可用范围是 1 … 3。默认值为 3。

平均时间
选择由用户定义并且设置时间平均间隔。默认值为 30 分钟。

平均高度
选择由用户定义并且设置高度平均间隔。默认值为 360 米（1181 英尺）。
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3. 选择 保存和 关闭。
要使用新预设，请选择添加图；并且对于预设，选择您创建的预设。
更多信息
‣ 混合高度算法 (页 13)

8.2.2 修改计算预设
您可以修改计算预设的值、将预设重置为默认值以及删除预设。
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保存新预设和已编辑的预设将关闭除实时默认图之外所有打开的图，并且重置视图。

1. 在 BL-View 中，选择系统 > 设置 > 预设。
2. 从左侧的列表中选择一个预设。 

无法修改 默认预设。
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3. 选择以下选项之一：
• 要将这些设置重置为默认值，请选择重置。
• 要删除某一预设，请选择删除。
• 要修改算法设置，请参见修改计算预设的算法设置 (页 74)。
• 要修改某一现有预设，请编辑值：

边界层最小值
设置报告的最低边界层高度。
可用范围是 30 … 500 米（99 … 1640 英尺）。默认值为 30 米（99 英
尺）。

边界层最大值
设置报告的最高边界层高度。
可用范围是 200 … 4000 米（656 ... 13120 英尺）。默认值为 4000 米
（13120 英尺）。

边界层数
设置在 BL-View 中显示的最多边界层数。
可用范围是 1 … 3。默认值为 3。

平均时间
选择由用户定义并且设置时间平均间隔。
默认值为 30 分钟。

平均高度
选择由用户定义并且设置高度平均间隔。
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默认值为 360 米（1181 英尺）。

4. 选择 保存和 关闭。
对于使用修改的预设的那些图，更改反映在信息面板中。
更多信息
‣ 混合高度算法 (页 13)

8.2.3 修改计算预设的算法设置
您可以修改 合并式、梯度和廓线拟合、梯度和 廓线数据的算法设置。
这些修改仅适用于该预设。使用同一算法的其他预设保持不变。
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保存新预设和已编辑的预设将关闭除实时默认图之外所有打开的图，并且重置视图。

1. 在 BL-View 中，选择系统 > 设置 > 预设。
2. 从左侧的列表中选择一个预设。 

无法修改 默认预设。

3. 在 算法方法中，选择要修改的算法，然后选择 编辑。
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4. 在 高级算法设置中，修改设置。 

可用设置取决于所选算法。

5. 对于 梯度设置，设置 算法灵敏度。 
可用范围是 0 … 20。默认值为 5。
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6. 对于 廓线拟合设置，设置以下内容： 
SNR

设置信噪比。
可用范围是 0 … 100。默认值为 1。

SNR 平均窗口
设置信噪比的平均窗口。
可用范围是 20 … 1000 米（66 ... 3280 英尺）。默认值为 500 米（1640 英
尺）。

夜间模式长度
设置夜间模式长度。
可用范围是 10 … 4500 米（33 ... 14760 英尺）。默认值为 1000 米（3280 英
尺）。

日间模式长度
设置日间模式长度。
可用范围是 10 … 4500 米（33 ... 14760 英尺）。默认值为 4000 米（13120 英
尺）。

剔除异常值强度
设置剔除异常值强度。
可用范围是 0 … 500。默认值为 60。

7. 选择 确定。
8. 选择 保存和 关闭。

对于使用修改的预设的那些图，更改反映在信息面板中。
要使用修改的预设，请选择 添加图；并且对于 预设，选择您修改的预设。

8.3 更改重叠校正系数
重叠校正系数影响默认实时图。
您可以定义重叠校正系数是否应用于数据，以及要使用的重叠校正系数。

1. 在您的计算机上，转到以下文件夹： 
C:\Program Files (x86)\Vaisala\BL-View\config.
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2. 使用记事本打开文件 bl_calc_srv.ini。 
对于每个设备，该文件都包含与重叠校正相关的 2 个设置：

USE_OVERLAP_CORRECTION=[S]"YES"
OVERLAP_CORRECTION_FILE=[S]"C:\Program Files (x86)\Vaisala\BL-View\config
\overlap_correction_profile.dat"

参数 说明/值
USE_OVERLAP_CORRECTION 定义是否将重叠校正系数应用于数据

No（默认值）
Yes

OVERLAP_CORRECTION_FILE 定义重叠校正文件的位置和名称。
默认位置为 C:\Program Files
(x86)\Vaisala\BL-View\config
默认文件名为
overlap_correction_profile.dat

3. 如果您想要定义设备特定的重叠校正系数，则为每个设备都创建单独的重叠校正文
件。
a. 例如，对于 2 个设备，在文件夹中创建以下文件 

C:\Program Files (x86)\Vaisala\BL-View\config:
• overlap_correction_profile_CL31_Helsinki.dat
• overlap_correction_profile_CL51_Vantaa.dat
从现有文件 overlap_correction_profile.dat 复制文件内容。

b. 转到文件夹 C:\Program Files (x86)\Vaisala\BL-View\config 并且在
记事本中打开文件 bl_calc_srv.ini。

c. 在 bl_calc_srv.ini 中，定义重叠校正文件的位置和名称。 

[CEILOMETER_1]
...
OVERLAP_CORRECTION_FILE=[S]"C:\Program Files (x86)\Vaisala\BL-View\config
\overlap_correction_profile_CL31_Helsinki.dat"

[CEILOMETER_2]
...
OVERLAP_CORRECTION_FILE=[S]"C:\Program Files (x86)\Vaisala\BL-View\config
\overlap_correction_profile_CL51_Vantaa.dat"
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4. 要调整某一云高仪的近距离范围性能，请调整重叠校正系数。 
转到文件夹 C:\Program Files (x86)\Vaisala\BL-View\config 并且在记
事本中打开正确的重叠校正配置文件，然后编辑相关信息。
该重叠校正系数用于与在级别 2 (L2) 配置文件中指定高度处的反向散射值相乘。下面
是一个示例，说明如何将针对 10 米（3 英尺 3 英寸）的重叠校正系数从 1.02 更改为
1.00。
原始设置：

TERENO Fendt correction factors
1.3    Version of this correction file
1.2    Sensitivity correction factor
Overlap correction factors
1.02        10 m
1.01        20 m
1.01        30 m
1.02        40 m
...

修改后的设置：

TERENO Fendt correction factors
1.3    Version of this correction file
1.2    Sensitivity correction factor
Overlap correction factors
1.00        10 m
1.01        20 m
1.01        30 m
1.02        40 m
...

高于 360 米（1181 英尺）时，重叠校正系数为 1.0。
5. 保存后关闭该文件。
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9. 使用文件
9.1 导入 DAT 文件
使用导入服务将 CL-VIEW DAT 文件导入到 BL-View。导入后，您可以查看 BL-View 中的信
息。
在将 DAT 文件导入 BL-View 前，您可以将信息添加到文件并更改 DAT 文件中的信息间
隔。

在更改 INI 文件前请备份它。以后您可以根据需要恢复数据。

9.1.1 更改导入文件中的云高仪标识数据
在将 DAT 文件导入 BL-View 前，您可以将一些信息添加到文件，例如：

• 纬度、经度和海拔高度信息
• UTC 偏移量
1. 转到您的计算机上的以下文件夹： 

C:\Program Files (x86)\Vaisala\BL-View\config

2. 使用 Microsoft 记事本打开文件 level_one_import.ini。
3. 更改文件中的 2 个位置，然后选择文件 > 保存。

9.1.2 更改导入文件中的信息间隔
BL-View 在绘制数据时使用 16 秒消息间隔。
如果您的 DAT 文件包含不是使用 16 秒间隔记录的数据，必须更改 DAT 文件的设置。转换
服务需要该信息，以便 BL-View 可以正确显示数据。

1. 转到您的计算机上的以下文件夹： 
C:\Program Files (x86)\Vaisala\BL-View\config

2. 使用 Microsoft 记事本打开文件 level_one_import.ini。
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3. 将实例信息从： 

[__INSTANCES__]
L1_INPUT_AUTO=YES
L1_INPUT_USER_DEF=NO

更改为：

[__INSTANCES__]
L1_INPUT_AUTO=NO
L1_INPUT_USER_DEF=YES

4. 更改信息间隔信息。 
DAT 文件的信息间隔必须为 2 ... 75 秒。
例如，如果已按 30 秒间隔记录了 DAT 文件，请将该信息从：

[L1_INPUT_USER_DEF]
DIRECTORY=[S]"LevelOneImport"
RUN_MODE=[S]"UserDefined"
    ; Message interval (2-75 seconds, default 16).
MESSAGE_INTERVAL=[I]16
    ; Time span of one DAT file (1-24 hours, default 6).
DAT_FILE_SIZE=[I]6

更改为：

[L1_INPUT_USER_DEF]
DIRECTORY=[S]"LevelOneImport"
RUN_MODE=[S]"UserDefined"
    ; Message interval (2-75 seconds, default 16).
MESSAGE_INTERVAL=[I]30
    ; Time span of one DAT file (1-24 hours, default 6).
DAT_FILE_SIZE=[I]6

5. 选择文件 > 保存。

9.1.3 导入数据（DAT 文件）
使用导入服务将 CL-VIEW DAT 文件导入到 BL-View。
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• 如果已按 16 秒时间间隔以外的其他时间间隔记录了 DAT 文件，请参见更改导入文件
中的信息间隔 (页 81)。

• 如果您想要将云高仪名称、纬度、经度和 UTC 偏移信息添加到导入文件，请参见更
改导入文件中的云高仪标识数据 (页 81)。

1. 将名为 LevelOneImport 的文件夹创建到以下位置： 
C:\Program Files (x86)\Vaisala\BL-View\bin

2. 复制您要导入到您创建的文件夹的文件： 
C:\Program Files (x86)\Vaisala\BL-View\bin\LevelOneImport

3. 检查文件 level_one_import.ini 是否处于以下文件夹中： 
C:\Program Files (x86)\Vaisala\BL-View\config

4. 要打开命令提示符，请选择开始，右键单击命令提示符，然后选择以管理员身份运
行。

5. 在命令提示符窗口，要转入主级别，请键入： 

cd C:\

6. 要转至包含用于运行导入的应用程序的文件夹，请键入： 

cd C:\Program Files (x86)\Vaisala\BL-View\bin

7. 要重新启动服务，请键入： 

roaadmin.exe reload

8. 要运行导入，请键入： 

level_one_import.exe

根据 DAT 文件的数目，导入过程可能需要较长时间。在所有 DAT 文件均已处理后，
导入将停止。

9.2 屏幕瞬时截图（PNG 文件）
您可以创建屏幕截图以便将当前图导出为图像文件 (PNG)。

1. 在 BL-View 中，选择工具 > 截图 > 瞬间。
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2. 键入图像名称，然后选择要保存该图像的目录。
3. 选择保存。 

保存的图像将在图像顶部显示设备名称、日期以及与所使用的算法有关的信息。
如果您已经放大了密度图，则图像将包含放大的视图。

更多信息
‣ 图像文件 (PNG) (页 43)

9.3 计划快照（PNG 文件）
您可以计划按特定时间间隔进行的屏幕截图。图将保存为图像文件 (PNG)。

1. 在 BL-View 中，选择云高仪。
2. 如果您想要计划针对某一自定义图的屏幕截图，则打开一个自定义实时图。
3. 选择工具 > 截图 > 已计划。
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4. 在计划截图中，设置以下内容： 
计划截图

选择打开。
图

选择实时图或自定义图。只有在打开了某一自定义实时图的情况下，您才能计
划自定义图的屏幕截图。
对于每个设备，您只能计划一个自定义实时图。

截图时间
选择一天的第一个屏幕截图的时间。
在每个 24 小时时间段的开始时应用该设置。

截图频率
选择进行屏幕截图的频率。
可用范围是 1 … 24 小时。默认值为 1。
例如，如果您将屏幕截图时间设置为 9.15 并且将屏幕截图频率设置为 5，则执
行第一次屏幕截图的时间为 9.15，接下来依次在 14.15、19.15、00.15、5.15
执行屏幕截图，第二天再次从 9.15 开始。

文件路径
选择要保存屏幕截图的目录。
在您指定的目录中，创建一个名为 Snapshot 的文件夹，在这个文件夹中，每
个设备都有单独的文件夹来存放文件。
Snapshot 目录用于所有设备和实时图的计划截图。
默认目录为 C:\BLViewData，在该目录中还保存 netCDF 文件。
更改此处的文件路径不会影响 netCDF 文件的存储位置。
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5. 选择确定。 
保存的图像将在图像顶部显示设备名称、日期以及与所使用的算法有关的信息。
如果您已经放大了密度图，则图像将包含放大的视图。

要确保计划的执行，请注意以下方面：
• 如果您关闭启用了计划的某个图，则在系统询问是否禁用该计划时选择取消。
• 如果您为默认的实时图和某一自定义实时图定义了计划的屏幕截图，并且您关闭了

BL-View，则会保存该计划。下次您打开 BL-View 时，它将显示该默认的实时图和自
定义实时图。

更多信息
‣ 图像文件 (PNG) (页 43)
‣ 查看实时数据 (页 58)

9.4 导入数据（HIS 文件）
您可以将归档云高仪数据从 BL-View 导出到 HIS 文件。这些文件采用 ASCII 格式。

1. 在 BL-View 中，选择云高仪。
2. 选择工具 > 数据导出。
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3. 在预设中，选择用于对数据进行分析的算法。

4. 在日历中，选择已归档数据的日期，然后选择确定。
5. 选择以下选项之一：

• 要查看数据，请选择打开。
• 要在以后访问文件，请选择关闭。

这些文件存储于以下目录中：
C:\Program Files (x86)\Vaisala\BL-View\bin\History\<month>.
更多信息
‣ HIS 文件 (ASCII) (页 43)

9.5 访问 netCDF 文件
BL-View 自动将实时数据和归档数据存储到 netCDF 文件。

您可以将 netCDF 文件与其他用户共享，以便在不同的计算机上和 BL-View 中查看。将
L2 文件用于此目的。

1. 要访问 netCDF 文件，请转至您指定为存储位置的文件夹。默认存储位置为
C:\BLViewData。每台设备都具有针对这些文件的单独文件夹。

2. 要更改该存储位置，请在 BL-View 中选择系统 > 设置 > 设备。在数据和文件路径中，
选择浏览...以便定义存储 netCDF 文件的位置。 
在此目录中为指定的设备名称创建一个文件夹。

更多信息
‣ NetCDF 文件 (页 46)
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9.6 共享 netCDF 文件
您可以打开您的同事与您共享的 BL-View 级别 2 (L2) netCDF 文件。
更多信息
‣ NetCDF 文件 (页 46)
‣ 获取使用其他 BL-View 版本收集的数据 (页 38)
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10. 管理云高仪
10.1 打开终端连接
BL-View 使用 IO Terminal 提供到云高仪的连接。IO Terminal 通过通信端口连接到云高
仪。

1. 在 BL-View 中，选择工具 > IO Terminal。
2. 在 Connection control 面板中，选择云高仪和 Connect。在 Warning 窗口中，选

择 OK。 

连接将打开。状态栏显示连接状态。
如果云高仪处于自动发送模式下，信息将显示在 Terminal 面板中。

打开 IO Terminal 到云高仪的连接时，云高仪不向 BL-View 发送数据。警告

即使在安装了 CL51 的情况下，IO Terminal 也始终将 CL31 显示为云高仪类型。
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10.1.1 修改终端显示设置
您可以通过 Terminal 面板的 Settings 框架中的选择，来修改终端设置。这些设置定义
Terminal 面板中显示传感器信息和命令的方式。

• 选择 Visible symbols for binary 可将无法打印的字符（二进制值）显示为符号。
• 如果您希望应用程序模拟 VT100 终端，请选择 VT100。
• 选择 Local echo 以显示您在屏幕的 Terminal 面板上键入的命令。在这种情况下，

命令可能在屏幕上显示两次：一次通过您的工作站，一次通过现场设备。
• 选择 CRLF Mode 以使系统在每个信息行之后插入回车 (CR) 和换行符 (LF)。
• 选择 Auto LF 以使系统在屏幕上从现场设备接收的每个信息行之后都插入新的一行。

这便于您查看现场设备信息。
• 选择 Auto wrap 以使系统在屏幕上的 80 个字符之后开启新行。这样，您无需滚动即

可看到屏幕上的所有文本。

10.2 打开和关闭通信端口
在串行通信中使用的通信端口有 2 种内部状态：

• 已关闭：这是测量数据信息的传输状态。在此状态下，传输信息。不接受用户命令，
但 open 命令除外，后者会将线路转换为打开状态。

• 打开：这是用户对话状态。在此状态下，设备响应用户命令并回显命令输入。在打开
状态下不会自动传输任何测量数据信息。

1. 打开与云高仪的连接。请参见打开终端连接 (页 89)。
2. 要打开云高仪的通信端口，请在 Terminal 面板中键入 open，然后按 ENTER。 

命令模式启动，以下命令提示符显示在屏幕上：

CEILO >

云高仪已准备好接收用户输入的命令。
有关完整的命令列表，请参见 Vaisala Ceilometer CL31 User Guide 和 Vaisala
Ceilometer CL51 User Guide。

3. 要关闭云高仪的通信端口，请在 Terminal 面板中键入 close，然后按 ENTER。
云高仪中的数据信息显示在 Terminal 面板中。

10.3 记录数据
您可以将来自 IO Terminal 的数据记录到某个目录。

1. 要开始将数据记录到某个临时目录，请选择 Log > Log to file。 
该目录由用户的 TMP 环境变量定义。
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2. 要在每行开头添加时间戳，请选择 Log > If logging use timestamps。 

关闭 IO Terminal 时记录自动结束。

10.4 保存云高仪信息
为进行故障排除，您可以保存或打印云高仪信息以及在 Terminal（终端）面板上显示的
已发送命令。

1. 要复制来自 Terminal 面板的所有文本，请右键单击 Terminal 面板并选择 Copy。
2. 打开一个文本编辑器，如 Windows 记事本。在此复制-粘贴文本并保存文件。
3. 要打印来自 Terminal 面板的所有文本，请选择 Print。

10.5 关闭终端连接
打开 IO Terminal 到云高仪的连接时，云高仪不向 BL-View 发送数据。警告

关闭到云高仪的终端连接。关闭该连接将恢复在 BL-View 中进行云高仪数据记录。
1. 在 IO terminal 中，选择 Disconnect。 

关闭该连接。状态栏显示连接状态。

10.6 关闭 IO Terminal
要关闭 IO Terminal，请选择 File > Exit。
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11. 故障排除
11.1 查看警报
云高仪名称旁边的图标指示警报状态。
表 19 警报状态

图标 说明
无警报

1 个或多个警告
测量数据有效
1 个或多个警报，可能还有警告
测量数据可能无效

要在 BL-View 中查看活动警报，请选择 警报。

图 9 BL-View 警报窗口
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BL-View 报告有关以下问题的警报和警告：
• BL-View 软件
• 云高仪状态
• 云高仪和 BL-View 之间的接口
• 系统错误

11.1.1 BL-View 警报
表 20 BL-View 状态，警告

状态信息 原因 说明
Disk space low 为历史文件夹中的历史文件分配的

可用磁盘空间已减少为信息中指示
的空间量。系统仍将继续保存历史
文件。

请在历史文件夹中释放更多磁盘空
间。

Message interval warning 所选传感器数据信息发送频率对于
BL-View 不是最佳的（16 或 36
秒）。

根据云高仪类型设置信息间隔：
• CL31：16 秒
• CL51：36 秒
请参见配置云高仪 (页 25)。

Too old archive
directories found

历史文件包含太旧的自动清理报告
目录。

默认情况下，禁用自动磁盘清理。
请与维萨拉技术支持部门联系。

表 21 BL-View 状态，警报
状态信息 原因 说明
Checksum error 校验和计算错误。 默认情况下，禁用校验和计算。请

与维萨拉技术支持部门联系。
Configuration alarm 对于临时 XOA 文件没有足够的空

间。
请释放更多磁盘空间。

Message interval error 传感器数据间隔必须介于 2 到
75 秒之间。

将传感器数据信息发送频率设置为
2 ... 75 秒。请参见 BL-View 连接
设置 (页 30)。

Missing ceilometer data 传感器未连接。 检查 IO Terminal 到云高仪的连接
是否已断开。如有必要请更换它。

传感器通信设置不正确。 检查云高仪和 BL-View 之间的通信
设置是否匹配。

Out of disk space 为历史文件夹中的历史文件分配的
可用磁盘空间已减少到预定义的限
值以下。系统已停止在历史文件中
保存数据。

请在历史文件夹中释放更多磁盘空
间，以便可以继续保存。当历史文
件夹中存在足够的可用磁盘空间
时，系统将继续保存历史文件。

Output directory error 指定的目录路径无效。 重新启动您的计算机。
Port error BL-View 无法打开串行端口。 请确保计算机有相应的串行端口。

如果您正在使用 USB 延长器，请
验证它已连接、正常工作且不被其
他应用程序占用。
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状态信息 原因 说明
Unable to parse
ceilometer data message

BL-View 无法分析云高仪数据信
息。

检查 BL-View 通信设置中选择的信
息类型是否与云高仪设置匹配。如
有必要请更换它。

Roacontrol 检测到远程对象监视器故障。 系统错误。请与维萨拉技术支持部
门联系。

Roaobject 检测到对象信息冲突。
Roapersdatabase 读取 roapers.ini 中所列的文

件时出错。
Roauser 配置错误。

11.1.2 云高仪警报
更多详情，请参见：
• Vaisala Ceilometer CL31 User Guide
• Vaisala Ceilometer CL51 User Guide

表 22 云高仪状态，警告
状态信息 原因 说明
Battery failure 电池失效。 更换电池。
Battery voltage low 该装置使用备用电池供电的时间太

长。
请连接线电压或更换电池。

电池无法充电。 如果电池太旧，请将其更换。如果
电池状态良好，请检查云高仪引擎
板 CLE321 的运行情况。

Blower failure 吹窗器电缆未连接。 检查吹窗器电缆是否已连接。
吹窗器断路器未打开。 检查吹窗器断路器是否打开。
线电压电平不正确。 检查线电压是否存在并正确。
吹窗器卡住。 检查是否可见障碍物造成吹窗器运

行故障。
吹窗器受损。 更换吹窗器。
吹窗器正在吹风，但是只有冷空
气。吹窗器的加热器发生故障。

更换吹窗器。

Ceilometer engine board
failure

云高仪引擎板 CLE321 出现非关键
故障。

更换云高仪引擎板 CLE321。

Heater fault 吹窗器断路器未打开。 检查吹窗器断路器是否打开。
线电压电平不正确。 检查线电压是否存在并正确。
加热器受损。 更换加热器。
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状态信息 原因 说明
High background radiance 阳光直射。 如果没有警报，则测量正常。如果

存在警报，则测量无效。
High humidity（选项） 相对湿度 > 85 %。水在云高仪内

发生凝结。外壳或门渗漏。
将云高仪放在室内，打开维护门并
让其在装有暖气空调的地方变干。
光学元件表面的凝结水可能会干扰
测量结果。存在短路危险。

Humidity sensor failure
（选项）

湿度传感器未连接。 连接湿度传感器或在软件中禁用该
选件。

湿度传感器受损。 与技术支持部门联系并将云高仪寄
送到服务中心以更换湿度传感器。

Laser monitoring failure 激光功率监控器板 CLM311 发生故
障。

更换 CLM311。

云高仪引擎板 CLE321 中的激光功
率测量失败。

更换 CLE321。

Receiver warning CLR321 接收器出现非关键故障。 更换 CLR321。
Tilt angle > 45 degrees
warning

该装置未正确安装或倾斜角度大于
45°。

请检查安装。由于倾斜角度大于
45°，降低了高度测量准确度。

Transmitter expires 激光二极管太旧。 更换发射器 CLT321。测量数据有
效，但可能会错过一些云。

Window contamination（不定
时出现并持续时间 5 分钟以下）

通常是细雨滴到了窗口上。 吹窗器将清洁窗口。如果探测到
云，则高度信息正确。如果未探测
到云，可能缺失高云信息。

Window contamination（连
续）

例如，鸟粪、树叶或灰尘等污染了
窗口。

清洁窗口。

Working from battery 该装置的电池电量最多只能维持
1 ... 2 小时。

请连接线电压或更换电池。

表 23 云高仪状态，警报
状态信息 原因 说明
Ceilometer engine board
failure

云高仪引擎板损坏。 更换云高仪引擎板 CLE321。

Coaxial cable failure 同轴电缆断开或损坏。 请验证连接或更换同轴电缆。
Light path obstruction 窗口被严重污染或划伤。 清洁窗口，如果受损，请更换

CLW311。
激光束受阻。 检查光路的清澈度。

Memory error CLE321 内存发生故障。 更换 CLE321。
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状态信息 原因 说明
Receiver failure 接收器 CLR321 受损。 更换 CLR321。

电缆连接松动。 确认接收器 CLR321 和云高仪光学
元件 CLO321 的电缆未受损并且连
接正确。

接收器测试无法进行。 确认光学元件 CLO321 没有放错位
置或受损。如果 CLO321 装置损坏
或缺失，请与维萨拉公司联系以进
行维修和更换，因为 CLO321 装置
无法在现场更换。

Receiver saturation 阳光直射。 等待太阳从视野中消失。云高仪恢
复正常运行状态。

激光束部分受阻。 检查光路的清澈度。
Transmitter failure 激光老化或受损。 更换激光发射器 CLT321。

激光没有获得电源。 从状态信息中检查线电压是否标记
为 OK（正常）。

Transmitter shut-off（激光
温度 > 85 °C）

由于阳光直射，导致激光温度升
高。

等待太阳从视野中消失。云高仪恢
复正常运行状态。

环境温度过高。 检查温度过高是否存在特定原因。
Voltage failure 云高仪引擎板 CLE321 损坏。 更换 CLE321。
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11.2 查看事件日志
BL-View 保留显示警报历史记录的系统级事件日志。一天的事件记录在该文件中。

1. 要访问事件日志，请转到 C:\BL-View\History\<年>\<月>. 
一天对应一个文件。文件名的格式为 B_EVENTS_<月中某日>.his。

History file
TIME, SITE, MSG, CAT, ST, STATUSTEXT
2018-04-17 05:21:23, CL31  C2, BLOWER IS ON, TECH, 4, INFO
2018-04-17 05:21:23, CL31  C2, BLOWER HEATER IS ON, TECH, 4, INFO
1970-01-01 00:00:22, DEFAULT, OBJECT INFORMATION CONFLICT DETECTED BY SERVER A, TECH, 
2, ALARM
2018-04-17 05:22:42, DEFAULT, OBJECT INFORMATION CONFLICT DETECTED BY SERVER A, TECH, 
2, ALARM
2018-04-17 05:22:42, DEFAULT, OBJECT INFORMATION CONFLICT DETECTED BY SERVER A, TECH, 
0, OVER

表 24 事件日志信息
名称 说明 详细信息
TIME 发生事件的时间 格式 YYYY-MM-DD HH:MM:SS
SITE 系统 > 设置 > 设备中定义的设备名称。 -
MSG 事件的说明 请参见 BL-View 警报 (页 94)和云高仪

警报 (页 95)。
CAT 事件类别 技术 (TECH)、操作 (OPER)、信息 (MES)
ST 事件状态 0 = 结束

1 = 已确认
2 = 警报
3 = 警告
4 = 信息
5 = 拖延

STATUSTEXT 事件的严重性 INFO, WARNING, ALARM

11.3 撰写问题报告
在排除产品故障时，撰写问题报告，其中包括：

• 发生了什么故障（什么工作/什么不工作）？
• 在何处发生故障（位置和环境）？
• 发生故障的时间（日期，当即/过了一会儿/周期性的/无规律的）？
• 有多少故障（只有一处/其他与此相同或类似的故障/一个装置中有几处故障）？
• 发现故障后采取了什么措施？
• 产品与什么装置或连接器连接？

BL-View 用户指南 M211185ZH-D

98



• 与电力输出相连的输入电源源类型、电压和其他（例如照明、加热器和电动机）。
• 所有部件是否都正确连接和接地？拍照以便帮助排除故障。
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词汇表
BL-View

请参见维萨拉边界层视图软件 (页 101)。
IO Terminal

IO Terminal 是通过通信端口连接到传感器和其他现场设备的终端软件。
MLH

请参见混合层高度 (页 101)。
云底

云底是具有最低海拔高度的云的可见部分。将云底表示为到平均海平面（或行星表
面）的米数或英尺数，或表示为百帕（hPa，等价于毫巴）中相应的压力水平。

后向散射
后向散射是指波、微粒或信号反射回它们来自的方向。

图
图是 BL-View 中数据的图形表示法。提供归档图和实时图。

大气边界层
请参见大气边界层 (页 101)。

大气边界层
大气边界层是靠近地面的空气层，它受传输到地表或从地表传来的日间热量、湿度或
动量的影响。大气边界层是大气层的最低部分。

混合层高度
混合层高度是源自地球表面的大气层特性或物质被湍流垂直混合过程分散到的最大
高度。

维萨拉边界层视图软件
维萨拉边界层视图软件是用于大气边界层分析的应用程序。

计算预设
计算预设是在绘制边界层时使用的一组算法参数。

边界层
边界层是靠近地面的空气层，它受传输到地表或从地表传来的日间热量、湿度或动量
的影响。

词汇表
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质保
有关标准质保条款和条件，请参见 www.vaisala.com/warranty。
请注意，因正常磨损、异常工作环境、操作或安装疏忽或未经授权的改动导致的设备损坏，不在任何此
类质保的范围之列。 有关每种产品质保的详细信息，请参见适用的供货合同或销售条款。

技术支持
请与 Vaisala 技术支持部门联系：helpdesk@vaisala.com。请至少提供以下支持信息：
• 产品名称、型号和序列号
• 安装地点的名称和位置
• 可对问题提供更多信息的技术人员的姓名和联系信息
有关详细信息，请参见 www.vaisala.com/support。

产品回收
回收再利用所有可用材料。

请遵守有关处置产品和包装的法律规定。
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